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 ) www.iranestekhdam.ir( است. شده نوشته  نادرستاي در گزینه .......... معناي واژه  -1

 گري) ) (تجلیل: بزرگداشت)، (تجلی: جلوه 2  ) (محاسن: ریش)، (خفایا: پنهان)1

 ) جسارت: دلیري)، (ترجیح: برتري) 4  ) (متلاطم: آشفته)، (ازدحام: شلوغی) 3

 1گزینه پاسخ کارشناس ایران استخدام: 

 

 ت، تاب، قهر، حکمت) به ترتیب در کدام گزینه آمده است؟ معنی درست واژگان (مذلّ -2

)www.iranestekhdam.ir ( 

 سستی، پایداري، خشمگین، دانایی  )2   ) خواري، فروغ، چیره، معرفت1

 ) زبونی، توانایی، غضب، سعادت4  ) فرومایگی، طاقت، چیرگی، دانش 3

 3گزینه پاسخ کارشناس ایران استخدام: 

 

 .خورد در همه ابیات به جز بیت گزینه .......... واژگان مترادف به چشم می  -3

)www.iranestekhdam.ir ( 

 خوف و رعب آمد به جاي عقل و هوش  /بسته شد عزم ملک را چشم و گوش ) 1

 دل گرانی مکن اي جسم که جان باز آمد  /مژدگانی بده اي نفس که سختی بگذشت ) 2

 چو کرکس بوي مرداري نخواهم  /چو بازان ساعد سلطان گزیدم ) 3

 اي از حسرت گلزار مرا بس بود ناله  /گو مبر جانب گلشن، قفسم را صیاد ) 4

 3گزینه پاسخ کارشناس ایران استخدام: 

 

 ) www.iranestekhdam.ir( در کدام گروه کلمه (غلط املایی) یافت می شود؟  -4

 استیصال و درماندگی، بزم و ضیافت، قسیم و صاحب جمال) 1

 سفله و فرومایه، عصاره و شیره، ضجه و شیون ) 2

 ضماد و مرهم، بحبوحه و میانه، مطاع و فرمانروا ) 3
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 مفرح و شادي بخش، فاحش و واضح، صریر و اورنگ ) 4

 4گزینه پاسخ کارشناس ایران استخدام: 

 

 ) www.iranestekhdam.ir(  در متن زیر چند غلط املایی وجود دارد؟ -5

«هرگاه حوادث به عاقل محیط شود باید که در پناه صواب رود و بر خطا اسرار ننماید و آن را ثبات عزم  

و حسن عهد نام نکند و اگر خار در چشم مستبد افتد در بیرون آوردن آن غفلت ورزد و آن را خار دارد 

آسمانی ایمان آرد و جانب دوراندیشی   غزاهاي شبهت کور شود. و بر خردمندي واجب است که به و بی 

 » .را مهمل نگذارد 

 دو  )2      یک ) 1

 چهار )4      سه  )3

 3گزینه پاسخ کارشناس ایران استخدام: 

 

 ) www.iranestekhdam.ir(  است؟ متفاوتساختار کدام واژه با بقیه  -6

 وحشی گري ) 2     کوهسار) 1

 هنرستان ) 4     نامهفرهنگ ) 3

 3گزینه پاسخ کارشناس ایران استخدام: 

 

 ) www.iranestekhdam.ir(  ........... .   به جز  مفهوم عبارت زیر با همه ابیات تناسب مفهومی دارد،   -7

حالی صواب آن باشد که جمله به طریق تعاون قوتی کنید تا دام از جاي برگیریم که رهایش ما در آن  «

 » .است 

 شیر ژیان را بدرانند پوست  /مورچگان را چو بود اتفاق  ) 1

 چه بود خراب گلستان گردد آن  /آب را چون مدد بود هم از آب ) 2

 به تنها و یارانم اندر کمند  /بند ز مروت نبینم رهایی ) 3
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 هزار طعنه دشمن به نیم جو نخرند  /اند در همه کار دو دوست با هم اگر یکدل ) 4

 3گزینه پاسخ کارشناس ایران استخدام: 

 

 ) www.iranestekhdam.ir( ......... .   به جزهمه ابیات با بیت زیر قرابت مفهومی دارد؛  -8

 اول اندیشه کند مرد که عاقل باشد»  /«سخن گفته دگر باز نیاید به دهن 

 روان سراینده رامش برد  /سخن چون برابر شود با خرد  )1

 چو ناباور افتد نماید دروغ  /سخن گر چو گوهر برآرد فروغ ) 2

 چو رنجش نخواهی سخن را بسنج  /بدان کز زبان است مردم به رنج ) 3

 روي به هر کس نوازنده و تازه  /سخن پیش فرهنگیان سخته گوي ) 4

 2گزینه پاسخ کارشناس ایران استخدام: 

 

 ) www.iranestekhdam.ir( است؟  متفاوتپیام نهایی کدام بیت با سایر ابیات  -9

 غنیمت دار در این وحشت سرا جمعیت خود را / باشد می به اندك زوري از هم تار و پود جسم  )1

 که عمرم بگذرد ایام گل در آشیان بستن  /شمارم صحبت گل نیستم بلبل غنیمت می ) 2

 رخشی است که همچو برق در تاختن است /از دست منه عنان فرصت که حیات ) 3

 ماند اي فرصت نمیکه تا بر خویشتن جنبیده  /به دام دوربینی صید کن این برق جولان را ) 4

 1گزینه پاسخ کارشناس ایران استخدام: 

 

 )www.iranestekhdam.ir(  مفهوم عبارت زیر با کدام بیت قرابت دارد؟ -10

 ایم.»«هنگامی که در فروتنی بزرگ باشیم، بیش از همه به آن بزرگ نزدیک شده 

 آن را که او به دانش والا شد  /خوي مهان بگیر و تواضع کن  )1

 تا صید کنی هزار دل در نفسی  /) چون زلف بتان شکستگی عادت کن 2



 

 
  

9 

 نماست مهربانی و تواضع از بزرگان خوش   /) سهل باشد گر کنند افتادگان افتادگی 3

 هست پیچیدن کلید قفل این گنجینه را  /) نشکنی تا خویش را از دوست کی یابی نشان؟ 4

 3گزینه پاسخ کارشناس ایران استخدام: 

 

 ) www.iranestekhdam.ir(  مفهوم بیت زیر است؟ فاقدکدام بیت  -11

 غنچه خاموش بلبل را به گفتار آورد»  /«مستمع صاحب سخن را بر سر کار آورد 

 چون مستمع نیابد پس چون کند روایت؟  /) عطار در دل و جان اسرار دارد از تو 1

 چو عالم نباشی کم از مستمع /) تنی چند بر گفت او مجتمع 2

 قطره در گوش صدف گوهر شهوار شود  /) سخن از مستمعان قدر پذیرد هیهات 3

 مگر مستمع را بدانم که کیست /) سماع اي برادر نگویم که چیست 4

 2گزینه پاسخ کارشناس ایران استخدام: 

 

 ) www.iranestekhdam.ir( در کدام عبارت، کژتابی وجود دارد؟ -12

 گیرد. ) ادبیات داستانی، همه آثار روایی را در بر می 1

 ) با خواندن هر متن داستانی باید، به درون محتواي آن بیاندیشیم.2

 ) پسرك تصویري از چهره پدرش کشید.3

 پذیرند. بخت، اندرز خیرخواهان را می ) فرزندان نیک 4

 3گزینه پاسخ کارشناس ایران استخدام: 

 

 ) www.iranestekhdam.ir(  در کدام گزینه شیوه نگارش تمامی کلمات درست است؟ -13

 پیشامد  - لاخ سنگ  -عالی ) جناب 2  بهوش (هوشیار)  -یکشنبه    -مند ) علاقه 1

 ربط ذي - دار جان  -قدس ) آستان 4   بیسواد –همنام   - متر ) میلی 3
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 1گزینه پاسخ کارشناس ایران استخدام: 

 

 ) www.iranestekhdam.ir( اند؟کدام یک از کلمات زیر به درستی جمع بسته شده  -14

 ) سبزیجات 2     ) مجروحین 1

 ) گزارشات4     ) معلمان 3

 2گزینه پاسخ کارشناس ایران استخدام: 

 

 ) www.iranestekhdam.ir(  است؟ نرفتههاي نگارشی به درستی به کار در کدام گزینه نشانه  -15

 ه.ق) است. 1344–1281نیشابوري ( یب) از شعراي دیگر این عصر اد1

 به خیر.  -  ترین چهره تاریخ آن شرکت استکه محبوب   - ) یاد مرحوم مهندس نادري 2

 هاي آموزشی براي همه کارکنان ضروري است.» گوید: «گذراندن دوره انسانی می  هاي) مدیر امور سرمایه 3

 ) سازمان، نیازمند مدیریتی قوي و شایسته است؛ نگذاریم گرفتار دیوان سالاري اداري شود.4

2 گزینهپاسخ کارشناس ایران استخدام: 



 

 

 
 

 

 

 

 

 

 

 :  دومبخش 
 

 هوش و استعداد تحصیلی
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 کدام شکل به جاي علامت سوال قرار بگیرد تا سري شکل زیر کامل گردد؟ -16

)www.iranestekhdam.ir ( 

1(      2( 

3(      4( 
 

 2گزینه پاسخ کارشناس ایران استخدام: 

 

آرزو مادر بهار، کاوه پسر آرزو، دانیال برادر الناز و الناز دختر بهار است، مادربزرگ    ، با توجه به اینکه  -17

 ) www.iranestekhdam.ir(  دانیال کیست؟

 ) بهار 2      ) آرزو 1

 ) خواهر بهار4     ) خواهر کاوه 3

 1گزینه پاسخ کارشناس ایران استخدام: 

 

 است؟  متفاوتها در کدام گزینه ارتباط میان جفت کلمات داده شده با سایر گزینه  -18

)www.iranestekhdam.ir ( 

 ) کشک و شیر 2     ) اتم و الکترون 1

 ) قطار و واگن 4     ) خانه و اتاق 3

 2گزینه پاسخ کارشناس ایران استخدام: 

 

باشد و «هنرور» معادل با عدد    51643اگر در یک زبان برنامه نویسی کلمه «مردان» معادل عدد    -19

 ) www.iranestekhdam.ir(  معادل با کدام کلمه است؟ 142354باشد. عدد  23171

 ) رهنورد 2     ) هنرمند 1

 ) همرهان 4     ) راهنما 3

 3گزینه پاسخ کارشناس ایران استخدام: 
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سسه خیریه باید تیمی از داوطلبان را براي تحقیق به مناطق کم برخوردار ارسال کند. او شش  و یک م

او   حداقل دو داوطلب را به    خواهد می داوطلب در اختیار دارد: مالک، زهرا، جواد، کاوه، سایه و بهار. 

 شهر بفرستد و در عین حال همواره حداقل دو داوطلب را در دفتر خیریه نگه دارد. 

 این شرایط باید در انتخاب تیم داوطلبان رعایت شود:

 ماند.الف) اگر مالک براي تحقیق برود، زهرا در دفتر خیریه می 

 رود. ب) اگر زهرا براي تحقیق برود، جواد نیز می 

 ماند.ج) اگر زهرا در دفتر خیریه بماند، سایه نیز در آنجا می

 توانند هر دو بروند یا هر دو بمانند. د) جواد و کاوه نمی 

 اند؟ تواند فهرستی از همه داوطلبانی باشد که براي تحقیق ارسال شده کدام یک از موارد زیر می -20

)www.iranestekhdam.ir ( 

 ) زهرا، کاوه، بهار2    ) سایه، بهار، زهرا 1

 ) مالک، سایه 4    ) زهرا، جواد، بهار3

 3گزینه پاسخ کارشناس ایران استخدام: 

 

توانند با یا بدون همراهی داوطلبان دیگر با هم براي تحقیق  کدام یک از جفت داوطلبان زیر می   -21

 ) www.iranestekhdam.ir(  بروند؟

 ) مالک و سایه 2     ) زهرا و کاوه 1

 ) زهرا و بهار4     ) کاوه و جواد 3

 2گزینه پاسخ کارشناس ایران استخدام: 

 

را در پاسخنامه علامت    25تا    20هاي  راهنمایی: اطلاعات زیر را بخوانید و با توجه به آن، پاسخ سوال 

 بزنید. 
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تواند فهرست کامل داوطلبانی باشد که در  اگر زهرا براي تحقیق برود، کدام یک از موارد زیر می   -22

 ) www.iranestekhdam.ir( مانند؟دفتر می

 ) کاوه و مالک 2    ) جواد، مالک و سایه 1

 ) بهار، جواد، مالک و سایه 4     ) بهار، جواد 3

 3گزینه پاسخ کارشناس ایران استخدام: 

 

 مانند؟ فهرست کامل داوطلبانی باشد که در دفتر می تواندنمی کدام یک از موارد زیر  -23

)www.iranestekhdam.ir ( 

 ) بهار، کاوه، سایه و زهرا 2    ) کاوه، سایه و زهرا 1

 مالک و سایه  ، ) بهار، کاوه4    ) بهار، کاوه و زهرا 3

 3گزینه پاسخ کارشناس ایران استخدام: 

 

 تواند درست باشد؟ اگر دقیقا دو داوطلب در دفتر بمانند، کدام یک از موارد زیر می  -24

)www.iranestekhdam.ir ( 

 ماند.) مالک در دفتر می 2   رود. ) کاوه براي تحقیق می 1

 ماند.) بهار در دفتر می 4    ماند. ) زهرا در دفتر می 3

 2گزینه پاسخ کارشناس ایران استخدام: 

 

گزینه  -25 از  یک  کدام  باشند،  داشته  را  وظیفه  یک  مالک  و  سایه  از اگر  معتبري  انتخاب  زیر  هاي 

 ) www.iranestekhdam.ir(  بزرگترین تیم ممکن براي تحقیق است؟

 ) بهار، جواد و زهرا 2    ) بهار، مالک و سایه 1

 ) مالک، سایه، زهرا و کاوه 4    ) بهار، جواد، کاوه و زهرا 3

 2گزینه پاسخ کارشناس ایران استخدام: 
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کند که اجراي طرح ترافیک مرکز شهر، ترافیک را کاهش داده و کیفیت هوا  شوراي شهر ادعا می   -26

کنند که از آنجایی که در ساعات اوج ترافیک، وسایل نقلیه  را بهبود بخشیده است. آنها استدلال می 

 شوند، این سیاست با موفقیت آلودگی هوا و زمان سفر را کاهش داده است. کمتري وارد این منطقه می

 )www.iranestekhdam.ir(   کدام یک از موارد زیر، فرض مورد نیاز براي استدلال شوراي شهر است؟

کنند از مسیرهاي جایگزین که ترافیک کمتري  ) رانندگانی که در ساعات اوج ترافیک از مرکز شهر اجتناب می1

 دارند، استفاده خواهند کرد. 

 ) کاهش تعداد وسایل نقلیه ورودي به مرکز شهر، در درجه اول به دلیل طرح ترافیک است، نه عوامل دیگر. 2

 هاي حمل و نقل عمومی در منطقه مرکز شهر در مدت مشابه کاهش یافته است.) گزینه 3

) خودروهاي وارد شده به مرکز شهر در ساعات اوج، به طور متوسط آلایندگی کمتري نسبت به گذشته تولید  4

 کنند.می 

 2گزینه پاسخ کارشناس ایران استخدام: 

 

«عملیات حفاري نفت در دریا با ریسک غیرقابل اجتناب نشت نفت همراه است، اما واردات نفت   -27

با استفاده از نفتکش ها در حال حاضر ریسک نسبی بیشتري به ازاي هر بشکه نفت دارد. بنابراین، اگر  

شتر در  بخواهیم ریسک نشت نفت را کاهش دهیم بدون اینکه مصرف نفت خود را کاهش دهیم، باید بی

عملیات حفاري دریایی سرمایه گذاري کنیم و کمتر نفت را با نفتکش ها وارد کنیم.» کدام یک از موارد  

 ) www.iranestekhdam.ir(  کند؟زیر اگر درست باشد، استدلال بالا را به شدت تضعیف می

 تر است. ها در حال حاضر نسبت به حفاري نفت در دریا ارزان ) واردات نفت با نفتکش 1

 ها به راحتی قابل باز طراحی هستند تا ریسک نشت نفت را کاهش دهند.) نفتکش 2

 تواند با مدیریت دقیق کاهش یابد.) تأثیر عملیات حفاري دریایی روي محیط زیست می 3

هاي ناشی از عملیات دریا بوده  تر از نشتها ایجاد شده است معمولا جدي هایی که توسط نفتکش ) نشت نفت 4

 است. 

ال مطرح شده، ولازم است موقعیتی را که در هر س  27و    26هاي  الوراهنمایی براي پاسخگویی به س

تري  تر و کاملکنید پاسخ مناسب مورد تجزیه و تحلیل قرار دهید و سپس گزینه اي را که فکر می

 ال است، انتخاب کنید. وبراي آن س 
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 2گزینه پاسخ کارشناس ایران استخدام: 

 

 ) www.iranestekhdam.ir(  تواند به جاي علامت سوال در شکل زیر قرار بگیرد؟کدام گزینه می   -28

7 4  2 9  5 6  4 8 

 ؟ 3  0 3  8 1  8 2

1 (1      2 (2 

3 (5      4 (7 

 2گزینه پاسخ کارشناس ایران استخدام: 

 

تا بیش از دو برابر    14در یک مزرعه که شامل تعدادي گوسفند و مرغ است، تعداد پاهاي حیوانات    -29

 ) www.iranestekhdam.ir( تعداد سرها است. چه تعداد گوسفند در این مزرعه وجود دارد؟

1 (2      2 (5 

3 (7      4 (9 

 3گزینه پاسخ کارشناس ایران استخدام: 

 

هاي پارچه را براي پیراهن تهیه کند. او هر رول با  هایی از رول خواهد تکه پارچه یک خیاط می   -30

دقیقه چند    24برش در دقیقه است. در    45دهد و سرعت برش او  تکه برش می   10طول مساوي را به  

 ) www.iranestekhdam.ir(  شود؟رول بریده می 

1 (120      2 (108 

3 (54      4 (32 

 1گزینه پاسخ کارشناس ایران استخدام: 
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از    -31 با شروع  را  از  شماره گذاري می  1یک چاپگر صفحات یک کتاب  و در مجموع  رقم   192کند 

 ) www.iranestekhdam.ir(  کند. این کتاب چند صفحه دارد؟استفاده می 

1 (84      2 (92 

3 (100      4 (120 

 3گزینه پاسخ کارشناس ایران استخدام: 

 

  20جوراب مشکی و    20پوشد. او در مجموع  اي می هایی به دو رنگ مشکی و قهوه مردي جوراب   -32

ها را در تاریکی بیرون بیاورد براي  اي در کشو خود دارد. فرض کنید مجبور باشد جوراب جوراب قهوه 

 اینکه مطمئن شود یک جفت جوراب هم رنگ دارد باید چند جوراب بیرون بیاورد؟ 

)www.iranestekhdam.ir ( 

1 (2      2 (3 

3 (11      4 (20 

 2گزینه پاسخ کارشناس ایران استخدام: 

 

ساعت به    6کند و در عرض  کیلومتر بر ساعت دوچرخه سواري می   30سورنا با سرعت متوسط   -33

 10کند. اگر سورنا سرعت متوسط خود را  ساعت طی می   4رسد مهران همین مسافت را در  مقصد می 

را   متوسط خود  مهران سرعت  و  بر ساعت  زمان    5کیلومتر  تفاوت  دهد،  افزایش  بر ساعت  کیلومتر 

 ) www.iranestekhdam.ir(  رسیدن آنها به مقصد چقدر خواهد بود؟

 دقیقه   42) 2     دقیقه   40) 1

 دقیقه   60) 4     دقیقه   54) 3

 3گزینه پاسخ کارشناس ایران استخدام: 

 



 

 
  

18 

نیم   -34 کاسه  داخلی  کره یک  شعاع  به  ظرف  سانتی  12اي  در  باید  مایع  این  است.  مایع  حاوي  متر 

متر ریخته شود. تعداد ظروف لازم براي خالی کردن سانتی   3سانتی متر و ارتفاع    4به قطر    اياستوانه 

 ) www.iranestekhdam.ir( کاسه برابر است با .......... .

1 (80      2 (86 

3 (96      4 (106 

 3گزینه پاسخ کارشناس ایران استخدام: 

 

هزار    200میلیون و    1براي خرید چند میز به قیمت هر کدام    هزارتومان  100میلیون و    8فردي    -35

ها به تعداد . نسبت تعداد صندلی کندمی هزارتومان هزینه  300تومان و چند صندلی به قیمت هر کدام 

 یز خریداري شده باشد، برابر است با .......... .ممیزها در حالتی که حداکثر تعداد ممکن 

)www.iranestekhdam.ir ( 

 2به  1) 2     1به  1) 1

 7به  5) 4     1به  2) 3

 2گزینه پاسخ کارشناس ایران استخدام: 



 

 

 
 

 

 

 

 

 

 

 :  سومبخش 
 

کامپیوتر 
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، و ... نمایش داده  2-1،  1-1به صورتی که مثلا    گذاري خودکار در تیترهابراي شماره    Wordدر   - 36

 ) www.iranestekhdam.ir( شوند باید از کدام بخش استفاده کرد؟

1  (Bullets and Numbering  2 (Multilevel List 

3(Outline view     4(Caption  

 2گزینه پاسخ کارشناس ایران استخدام: 

 

 شود؟بیشتر براي چه کاري استفاده می  wordدر  Mail Margeقابلیت  -37

)www.iranestekhdam.ir ( 

 ) ایجاد نمودار در سند 1

 ) درج پاورقی براي منابع 2

 ) ارسال نامه یا گواهی به افراد مختلف با یک قالب ثابت 3

  PDF) تبدیل سند به فایل4

 3گزینه پاسخ کارشناس ایران استخدام: 

 

اگر بخواهیم یک بخش از سند چند ستونی باشد ولی کل سند چند ستونی نشود،     Wordدر    -38

 ) www.iranestekhdam.ir( باید از کدام گزینه استفاده کنیم؟

1(page Break     2 (Section Break 

3(Column Break      4(Line Break  

 2گزینه پاسخ کارشناس ایران استخدام: 

 

 در کدام سربرگ قرار دارد؟  Spelling & Grammar، ابزار wordدر نرم افزار  -39

)www.iranestekhdam.ir ( 

1 (Home     2(insert 
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3(Review     4 (Layout 

 3گزینه پاسخ کارشناس ایران استخدام: 

 

براي اینکه یک متن با پاراگراف به طور کامل در یک صفحه باقی بماند و به صفحه منقل   Wordدر -40

 ) www.iranestekhdam.ir(  نشود، باید از کدام گزینه استفاده کنیم؟

1  (Insert → Page Break 

2  (퐻표푚푒 → Paragraph → Keep Lines Together 

3  (퐿푎푦표푢푡 → Columns  

4  (References → Cross Reference  

 2گزینه پاسخ کارشناس ایران استخدام: 

 

 شود؟ ها از کدام گزینه استفاده می براي درج خودکار سري داده  Excelدر  -41

)www.iranestekhdam.ir ( 

1 (Auto Complete    2(Pick from Drop Down List  

3 (Auto Fill     4(Auto List  

 3گزینه پاسخ کارشناس ایران استخدام: 

 

براي اینکه در یک خانه اعداد به صورت درصد نمایش داده شود، آن را از چه نوعی    Excelدر   -42

 ) www.iranestekhdam.ir(  کنیم؟تعریف می 

1 (Percentage    2(Fraction  

3 (Currency     4(Scientific  

 1گزینه پاسخ کارشناس ایران استخدام: 

 

 



 

 
  

22 

 ) www.iranestekhdam.ir(  نتیجه حاصل فرمول روبه رو در اکسل کدام گزینه است؟ -43

푫 = 2^3 ∗ 2 + 4 2⁄  

1 (144      2 (66 

3 (10      4 (18 

 4گزینه پاسخ کارشناس ایران استخدام: 

 

 ) www.iranestekhdam.ir(  براي چه منظوري است؟ TRANSPOSE، از تابع Excelدر  -44

 ) جمع و میانگین اعداد 1

 ها بین ردیف و ستون ) جابجایی داده 2

 ) ترکیب محتویات چند سلول در یک سلول 3

 ها به ترتیب صعودي یا نزولی سازي داده ) مرتب 4

 2گزینه پاسخ کارشناس ایران استخدام: 

 

به طوري که هنگام اسکرول کردن همیشه دیده شوند، از چه    هاها ستون براي قفل کردن ردیف  -45

 ) www.iranestekhdam.ir( کنیم؟اي استفاده می گزینه 

1  (View → Freeze Panes 

2  (Data → Sort 

3  (Review → Protect Sheet 

4  (퐼푛푠푒푟푡 → 푇푎푏푙푒 

 1گزینه پاسخ کارشناس ایران استخدام: 
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اگر در یک فرمول اکسل به آدرس سلول اشتباه یا ناموجودي ارجاع داده شود، کدام خطا ظاهر  -46

 ) www.iranestekhdam.ir( شود؟می

1  (! 퐷퐼푉 0#⁄     2  (! 푉퐴퐿푈퐸# 

3  (! 푅퐸퐹#     4  (? 푁퐴푀퐸# 

 3گزینه پاسخ کارشناس ایران استخدام: 

 

 استفاده کنیم و آن را کپی کنیم، نتیجه چه خواهد شد؟  A$1$اگر در یک فرمول اکسل از آدرس    -47

)www.iranestekhdam.ir ( 

 کند.) آدرس سلول به صورت نسبی تغییر می 1

 کند.اشاره می  A1) همیشه به همان سلول 2

 کند.تغییر می   A) به آخرین سلول موجود در ستون 3

!) خطاي  4 푅퐸퐹#  گرداند. برمی 

 2گزینه پاسخ کارشناس ایران استخدام: 

 

 چیست؟   Accountingو  Numberتفاوت بین فرمت  Excelدر  -48

)www.iranestekhdam.ir ( 

1  (Number کند ولی  بندي می فقط متن را قالبAccounting  .مخصوص تاریخ است 

2  (Number    و معمولی  اعداد  استفاده    Accountingبراي  مناسب  ترازبندي  با  پولی  مقادیر  نمایش  براي 

 شود.می 

3  (Number  به طور پیش فرض اعشار ندارد ولیAccounting   .دارد 

 ) هیچ تفاوتی ندارند.4

 2گزینه پاسخ کارشناس ایران استخدام: 
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 ) www.iranestekhdam.ir(  نسبت داد؟ Currencyدر اکسل چه مقداري را باید به نوع  -49

 ) عددي 2      ) متنی 1

 ) پولی 4    ) تاریخ و ساعت 3

 4گزینه پاسخ کارشناس ایران استخدام: 

 

 ) کدام کلیدها درست است؟ Stop) و توقف گذاري (Refreshبراي بارگذاري مجدد صفحه ( -50

)www.iranestekhdam.ir ( 

1( F 5 → Refresh, Esc → Stop 

2  (Ctrl + R → Stop, F 5 → Refresh 

3  (F 12 → Refresh, Esc → Stop 

4  (F 5 → Stop, Ctrl + S → Refresh 

 1گزینه پاسخ کارشناس ایران استخدام: 

 

 شود؟ ، از کدام کلید ترکیبی استفاده می Internet Explorerبراي رفتن به صفحه بعدي در  -51

)www.iranestekhdam.ir ( 

1  (Alt + Left Arrow   2  (Alt + Right Arrow 

3  (Ctrl + Left Arrow   4  (Ctrl + Right Arrow 

 2گزینه پاسخ کارشناس ایران استخدام: 

 

 دهد؟ چه چیزي را نمایش می 퐈퐧퐭퐞퐫퐧퐞퐭 퐄퐱퐩퐥퐨퐫퐞퐫در پایین  (푺풕풂풕풖풔 푩풂풓)نوار وضعیت   -52

)www.iranestekhdam.ir ( 

 ) وضعیت بارگذاري صفحه و لینک مقصد 2    ) آدرس صفحه فعلی 1

 ) تنظیمات امنیتی Favorites     4 ) لیست 3
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 2گزینه پاسخ کارشناس ایران استخدام: 

 

شما باشد باید آن را در کدام علامت    ياگر بخواهید عبارت مورد جستجو دقیقا همانند خواسته   -53

 ) www.iranestekhdam.ir( قرار دهید؟ 

 ) پرانتز 2     ) کوتیشن 1

 ) کاما 4     ) ویرگول 3

 1گزینه پاسخ کارشناس ایران استخدام: 

 

در کدام حالت ماشین حساب ویندوز میتوان محاسبات ریاضی پیشرفته مانند جذر، توان لگاریتم    -54

 ) www.iranestekhdam.ir(   توابع نمایی را انجام داد؟

1 (Standard     2(Scientific  

3(Programmer     4(Statistics  

 2گزینه پاسخ کارشناس ایران استخدام: 

 

 براي حذف یک برنامه به صورت کامل از ویندوز، از کدام بخش باید اقدام کرد؟ -55

)www.iranestekhdam.ir ( 

1  (File Explorer 

2  (Control panel → Programs and Features 

3  (Task Manager → Startup 

4  (Run → temp 

 2گزینه پاسخ کارشناس ایران استخدام: 



 

 

 
 

 

 

 

 

 

 

 :  چهارمبخش 
 

 آشنایی با مفاهیم پولی و بانکی
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ها به منظور ایجاد تسهیلات لازم براي گسترش امور تولیدي و بازرگانی و خدماتی در قالب  بانک   -56

 ) www.iranestekhdam.ir( توانند اعطاي اعتبار نمایند؟ چه عقدي می 

 ) جعاله 2     ) مساقات 1

 ) تسهیلات اعتباري 4    ) مشارکت مدنی 3

 2گزینه پاسخ کارشناس ایران استخدام: 

 

باشد؟ دار نزد بانک رفاه کارگران چند ریال می گذاري مدتحداقل مبلغ لازم جهت افتتاح سرمایه   -57

)www.iranestekhdam.ir ( 

1 (500,000     2 (1,000,000 

3 (10,000,000    4 (100,000,000 

 2گزینه پاسخ کارشناس ایران استخدام: 

 

 ) www.iranestekhdam.ir( گویند. هاي بانکی ............ میبه شماره ملی حساب -58

 ) شاپرك 2      ) تابا 1

 ) شبا4      ) پایا3

 4گزینه پاسخ کارشناس ایران استخدام: 

 

ها مکلفند براي ارائه دسته چک به مشتریان خود صرفا از طریق سامانه ............ اقدام نمایند. بانک   -59

)www.iranestekhdam.ir ( 

 ) پایا2      ) صیاد 1

 ) چکاد 4     ) چکاوك 3

 1گزینه پاسخ کارشناس ایران استخدام: 
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 عنوان وسیله ............ استفاده کرد.چک فقط وسیله ............ است و نباید از آن به  -60

)www.iranestekhdam.ir ( 

 پرداخت  - ) دریافت 2    اعتبار  -) پرداخت 1

 پرداخت  - ) اعتبار 4    اعتبار  - ) دریافت 3

 1گزینه پاسخ کارشناس ایران استخدام: 

 

 هاي سپرده اشخاص ............ ممنوع است. اختصاص هرگونه ابزار پرداخت به حساب -61

)www.iranestekhdam.ir ( 

 سال تمام  12) بیشتر از 2    سال تمام  12) کمتر از 1

 سال تمام  7) بیشتر از 4    سال تمام  7) کمتر از 3

 3گزینه پاسخ کارشناس ایران استخدام: 

 

 استفاده از کارت هدیه صادره با چه کسی است؟ مسئولیت هرگونه سوء -62

)www.iranestekhdam.ir ( 

 ) کارمند صادرکننده 2    ) مشتري (دارنده کارت) 1

 ) بانک مرکزي 4    ) موسسه اعتباري 3

 1گزینه پاسخ کارشناس ایران استخدام: 

 

شفاف   -63 دستورالعمل  تراکنشبراساس  روزانه  سازي  انتقال  جهت  اعتباري  موسسه  بانکی،  هاي 

شده براي «مشتري حقیقی» و «مشتري حقوقی» کدام تشابه و  الکترونیکی وجوه بیش از سقف تعیین 

 ) www.iranestekhdam.ir(تفاوت را باید رعایت کند؟ 

 کدام الزامی نیست.) براي هیچ 1

 ) فقط مشتري حقیقی نیازمند اسناد مثبته است. 2

 ) تنها براي مشتري حقوقی تکمیل فیلد «بابت» الزامی است.3
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  10میلیارد و حقوقی    4سقف مشتري حقیقی    - ) هر دو نیازمند تکمیل فیلد «بابت» و ارائه اسناد مثبته هستند  4

 میلیارد ریال است.

 4 گزینهپاسخ کارشناس ایران استخدام: 

 

بایست به بانک تودیع  هاي دسته چک قبلی میجهت صدور دسته چک مجدد چند درصد از برگه  -64

 ) www.iranestekhdam.ir(شده باشد؟ 

 درصد   70) 2     درصد   50) 1

 درصد   90) 4     درصد   80) 3

 3گزینه پاسخ کارشناس ایران استخدام: 

 

تواند حساب خود را به علت  قانون چک، شخص دارنده چک تا چه مدتی می  14براساس ماده    -65

سرقت یا مفقودي نزد بانک توقیف نماید و پس از آن باید گواهی تقدیم شکایت نزد مقام قضایی را  

 ) www.iranestekhdam.ir( براي بانک بیاورد؟ 

 ) ده روز 2     ) یک هفته 1

 ) یک ماه 4     ) دو هفته 3

 1گزینه پاسخ کارشناس ایران استخدام: 

 

پذیرد؟  هاي زیر انجام می یک از سامانه وسیله کدامهاي بین بانکی به تسویه و پردازش تراکنش  - 66

)www.iranestekhdam.ir ( 

 ) سحاب 2      ) صیاد 1

 ) ساتنا4     ) چکاوك 3

 4گزینه پاسخ کارشناس ایران استخدام: 
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 هاي اعتباري/اقساطی بانک رفاه کارگران به مشتریان، چه نام دارد؟ پلتفرم آنلاین طرح  -67

)www.iranestekhdam.ir ( 

 ) پیوند 2      ) بتا 1

 ) شهاب4     ) همبانک رفاه 3

 1گزینه پاسخ کارشناس ایران استخدام: 

 

اي در بازه صورت دوره کدام طرح سپرده بانک رفاه کارگران، با محوریت دریافت وجه از مشتري به  -68

العمر، در راستاي ارائه خدمات زمانی مشخص و پرداخت سرمایه اندوخته شده و یا سود مستمر مادام

 ) www.iranestekhdam.ir( روزآمد و تکمیل سبد خدمات ارائه گردیده است؟ 

 ) فرا رفاه 2     دار ویژه ) مدت 1

 ) معین 4     ) رفاه فردا 3

 3گزینه پاسخ کارشناس ایران استخدام: 

 

مطالباتی که از شش ماه تا هجده ماه از سررسید آنان سپري شده باشد را مطالبات ............ گویند.   -69

)www.iranestekhdam.ir ( 

 ) سررسید گذشته 2     ) جاري 1

 الوصول ) مشکوك 4     ) معوق 3

 3گزینه پاسخ کارشناس ایران استخدام: 

 

که دارنده چک تا ............ ماه از تاریخ صدور چک براي وصول آن به بانک مراجعه نکند  در صورتی   -70

کیفري   ننماید، دیگر حق شکایت  پرداخت شکایت  تاریخ صدور گواهی عدم  از  ماه   ............ یا ظرف 

 ) www.iranestekhdam.ir(نخواهد داشت. 

 شش ماه  – ) سه ماه 2    شش ماه  –) شش ماه  1

 سی روز  – ) سی روز 4    یک ماه  – ) یک ماه 3

 1گزینه پاسخ کارشناس ایران استخدام: 
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 اشاره دارد؟  "حق برداشت فوري وجه از حساب بانکی"کدام مفهوم در بانکداري به  -71

)www.iranestekhdam.ir ( 

 ) سفته 2    دار ) سپرده مدت1

 ) سپرده جاري (دیداري) 4     ) اعتبار اسنادي 3

 4گزینه پاسخ کارشناس ایران استخدام: 

 

 ) www.iranestekhdam.ir(باشد؟  هاي زیر کمترین ریسک را دارا می گذاري یک از سرمایه کدام  -72

 گذاري مشترك هاي سرمایه ) صندوق 2    ) اوراق قرضه دولتی 1

 ) اوراق سهام پذیرفته شده در بورس 4    ) اوراق قرضه شرکتی  3

 1گزینه پاسخ کارشناس ایران استخدام: 

 

 ) www.iranestekhdam.ir( چاپ و نشر اسکناس چه نوع سیاستی است؟  -73

 ) مالی انبساطی 2     ) پول انبساطی1

 ) پولی انقباضی4     ) مالی انقباضی3

 1گزینه پاسخ کارشناس ایران استخدام: 

 

یک از ابزارهاي زیر، براي تضمین پرداخت تعهدات در قراردادهاي بانکی یا تجاري، توسط کدام  -74

 ) www.iranestekhdam.ir(شود؟ بانک صادر می

 ) چک 2         ) سفته 1

 ) تمبر مالیاتی 4    نامه بانکی ) ضمانت3

 3گزینه پاسخ کارشناس ایران استخدام: 

 

 ) www.iranestekhdam.ir( منظور از قیمت اسمی چیست؟  -75

 ) قیمت ذاتی 2     ) قیمت بازار1
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 ) قیمت ثبت شده در برگه سهام 4    ) قیمت مورد معامله 3

 4گزینه پاسخ کارشناس ایران استخدام: 

 

مالی که از محلی به محل دیگر قابل نقل و انتقال نباشد، اعم از اینکه استقرار آن ذاتی باشد یا به   -76

واسطه عمل انسان، به نحوي که انتقال آن مستلزم خرابی یا نقص خود آن محل شود، چه نام دارد؟ 

)www.iranestekhdam.ir ( 

 ) اموال غیرمنقول 2     ) اموال منقول 1

 ) اموال منصوب و ابنیه 4    ) اموال بنا و مستحدثات3

 2گزینه پاسخ کارشناس ایران استخدام: 

 

 ) www.iranestekhdam.ir(تورم عبارت است از افزایش ............ .  -77

 ها در یک سال) سطح قیمت2       ها) قیمت 1

 هاي مصرفی ) مستمر سطح قیمت 4   ها) مستمر سطح عمومی قیمت3

 3گزینه پاسخ کارشناس ایران استخدام: 

 

دارد؟   -78 اشاره  مشخص  زمان  مدت  در  پولی  واحد  یک  از  استفاده  دفعات  تعداد  به  مفهوم  کدام 

)www.iranestekhdam.ir ( 

 ) پایه پولی 2     ) نقدینگی1

 ) سرعت گردش پول 4     ) حجم پول 3

 4گزینه پاسخ کارشناس ایران استخدام: 

 

ها در شرایط طبیعی اقتصاد  مدت مردم در بانکهاي کوتاه ها و سود سپرده کاهش نرخ بهره بانک  -79

 ) www.iranestekhdam.ir(گذارد؟ چه تاثیري بر شاخص سهام می

 شود.) باعث کاهش سهام می 2  شود. ) باعث افزایش شاخص سهام می 1

 کدام) هیچ 4  ) بر روي شاخص سهام تاثیري ندارد. 3
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 1گزینه پاسخ کارشناس ایران استخدام: 

 

 ) www.iranestekhdam.ir(چیست؟  "بانک مرکزي جمهوري اسلامی ایران"وظیفه اصلی  -80

 هاي پولی ) نظارت بر شبکه بانکی و اجراي سیاست2   ) اعطاي تسهیلات به عموم مردم 1

 الحسنه خرد هاي قرض ) مدیریت صندوق 4   هاي تجاري ) رقابت با بانک 3

 2گزینه پاسخ کارشناس ایران استخدام: 



 

 

 
 

 

 

 

 

 

 

 :  پنجم بخش
 

زبان انگلیسی عمومی
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81- Will you .......... that John when you see him, please? 

(www.iranestekhdam.ir ) 

1) giving     2) be going to give 

3) give     4) to give 

 3گزینه پاسخ کارشناس ایران استخدام: 

 

82- That comedy was........... all the other movies I've ever watched. 

(www.iranestekhdam.ir ) 

1) the funniest    2) funnier 

3) as funny     4) funnier than 

 1گزینه پاسخ کارشناس ایران استخدام: 

 

83- She tried to stop the children .............. jumping ......... the river. 

(www.iranestekhdam.ir ) 

1) on/into     2) about / in 

3) from /on     4) from /into 

 4گزینه پاسخ کارشناس ایران استخدام: 

 

84- The food was .......... but the service was .............. . (www.iranestekhdam.ir ) 

1) wonderful/ terrible   2) wonderfully/terribly 

3) wonderful / terribly   4) wonderfully/terrible 

 1گزینه پاسخ کارشناس ایران استخدام: 
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85- Nader is a clever boy. He ................. no attention to what his classmates 

are telling about him. (www.iranestekhdam.ir ) 

1) pays     2) gets 

3) reports     4) follows 

 1گزینه پاسخ کارشناس ایران استخدام: 

 

86- The new university was built to be the top choice for international 

students ................ to study in the city.  (www.iranestekhdam.ir ) 

1) installing     2) attending  

3) graduating    4) hoping 

 2گزینه پاسخ کارشناس ایران استخدام: 

 

87- They have enough power to........ themselves from those who would 

hurt them. (www.iranestekhdam.ir ) 

1) interview     2) defend 

3) recharge     4) contract 

 2گزینه پاسخ کارشناس ایران استخدام: 

 

88- She looked at small ........ box at the back of the shop she really liked it. 

(www.iranestekhdam.ir ) 

1) frequent     2) backed 

3) wooden     4) false 

 3گزینه پاسخ کارشناس ایران استخدام: 
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89- My brother is studying photography in Tehran University. He always 

............. a camera with him wherever he goes. (www.iranestekhdam.ir ) 

1) needs     2) donates 

3) carries     4) describes 

 3گزینه پاسخ کارشناس ایران استخدام: 

 

90- I didn't really get what you just said because she was ............ a lot of 

noise. 

(www.iranestekhdam.ir ) 

1) making     2) getting 

3) hearing     4) doing 

 1گزینه پاسخ کارشناس ایران استخدام: 

 

91- Your tests came back from the medical .................. about an hour ago, and 

the results were negative.  (www.iranestekhdam.ir ) 

1) palace     2) embassy 

3) shrine      4) laboratory 

 4گزینه پاسخ کارشناس ایران استخدام: 

 

92- A: How can I find information about tourist cities? 

B: Please, check our guide .............. . (www.iranestekhdam.ir ) 

1) fact      2) site  

3) booklet     4) range 

 3گزینه پاسخ کارشناس ایران استخدام: 
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93- On average, 250 pilgrims visit the holy ........... every weekend from 

Easter to September. (www.iranestekhdam.ir ) 

1) hospital      2) embassy  

3) shrine      4) library 

 3گزینه پاسخ کارشناس ایران استخدام: 

 

94- Hamedan attracts a lot of.............tourists. from other cities of Iran. 

(www.iranestekhdam.ir ) 

1) international    2) domestic  

3) ancient     4) familiar 

 2گزینه پاسخ کارشناس ایران استخدام: 

 

95- Please don't............ that you must turn off the light when you leave. 

(www.iranestekhdam.ir ) 

1) recite     2) forget 

3) enjoy     4) prefer 

 2گزینه پاسخ کارشناس ایران استخدام: 

 

Close Test: 

Banks play a crucial role in the economy by providing financial services to 

individuals and businesses. One of their main functions is to accept deposits from 

customers, which can then be used to... )96( ... loans to borrowers. Customers 

earn... )79(  ... on their deposits, which encourages saving. Central banks, unlike 

commercial banks, are responsible for regulating the money supply and 

controlling inflation, and they implement monetary ... )98(  ... to maintain 

economic stability. Modern banking also offers electronic services, allowing 
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customers to perform transactions online or via mobile apps, which... )99(  ... the 

efficiency of financial operations. Finally, effective risk management is essential, 

as banks must evaluate borrowers’ creditworthiness to ... )100(  ... the possibility 

of loan  defaults. 

96- (www.iranestekhdam.ir ) 

1) collect     2) grant 

3) refuse     4) deposit 

 2گزینه پاسخ کارشناس ایران استخدام: 

 

97-  (www.iranestekhdam.ir ) 

1) fees     2) penalties  

3) fines     4) interest 

 4گزینه پاسخ کارشناس ایران استخدام: 

 

98-  (www.iranestekhdam.ir ) 

1) policies     2) deposits 

3) withdrawals    4) transfers 

 1گزینه پاسخ کارشناس ایران استخدام: 

 

99- (www.iranestekhdam.ir ) 

1) increases     2) decreases 

3) ignores     4) eliminates 

 1گزینه پاسخ کارشناس ایران استخدام: 
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100-  (www.iranestekhdam.ir ) 

1) increase     2) ignore 

3) minimize     4) celebrate 

 3گزینه پاسخ کارشناس ایران استخدام: 



 

 

 

 

 

 

 

 

 

 »محصولات مرتبط دانلودي  «

   یاستخدام  يهادر آزمون  یآمادگ يبراهاي آموزشی دانلود درسنامه

 خرید و دانلود 

 

 

 »محصولات مرتبط چاپ شده  «

 هاي استخدامی هاي چاپ شده براي آمادگی در آزمون سفارش کتاب 

 خرید و سفارش 

 

https://iranestekhdam.ir/%D8%AF%D8%A7%D9%86%D9%84%D9%88%D8%AF-%D8%AF%D8%B1%D8%B3%D9%86%D8%A7%D9%85%D9%87-%D9%87%D8%A7%DB%8C-%D8%A7%D8%B3%D8%AA%D8%AE%D8%AF%D8%A7%D9%85%DB%8C
https://ketab.iranestekhdam.ir/


 

 

 

 
 
 
 
 

 
 
 

 

 

 

 

 

 
 

 سرویس خصوصی خدمات عام المنفعه اخبار شغل و استخدام 

Www.IranEstekhdam.Ir 

 

   خود در مورد مطالب آن شنهادیلطفا هرگونه انتقاد و پ فایل؛  نیا تیفیدر جهت بهبود ک  ؛یخواننده گرام

 : دیینما مطرح  ر یزو یا با شماره تلفن   لیمی اآدرس گزارش مشکل را به یا و 

    soal@iranestekhdam.irآدرس ایمیل:                       021- 91300113شماره تلفن تماس:  

 

http://www.iranestekhdam.ir/

